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Module 4A:
Creating the 3D Model of
Right and Oblique Pyramids

In Module 4A, we will learn how to create 3D solid models of right-axis and
oblique-axis pyramid (regular or truncated) in the Autodesk Inventor program, which
shall be used as Derived Parts for their Work Surface, in the creation of a sheet metal part
wrapping a right or oblique (regular or truncated) pyramid, in Module 5B.

The basic steps in the creation of the 3D model of a regular right-axis pyramid
(one with the vertex) are summarized as follow:

Creating a Sketch with the polygonal profile of the base of the pyramid, using
the Project Geometry to project the Center Point onto the Sketch for a
snap-point; and using the Polygon tool to draw the polygonal profile center-
snapped to the projected Center Point;

Creating a prism with the polygonal base profile using the Extrude tool with
a Distance that equals the height of the pyramid,;

Selecting the top surface of the prism to create a Sketch with the vertex point
of the pyramid, using the Project Geometry tool to project the Center Point
onto the Sketch as the vertex point;

Using the Work Plane tool to create a 3-point Work Plane feature with the
vertex point and two points from an edge of the pyramid’s base;

Using the Split tool with Split Part as Method and the Work Plane as Split
Tool to remove the unneeded volume;

Using the Circular Pattern tool with the Split feature as Features and the Y
Axis as Rotation Axis, to duplicate the Split feature around the prism, and to
change the prism into a pyramid.

The basic steps in the creation of the 3D model of an oblique-axis regular pyramid
(one with the vertex) are summarized as follow:
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e Creating a Sketch with the polygonal profile of the base of the pyramid, using
the Project Geometry to project the Center Point onto the Sketch for a
snap-point; and using the Polygon tool to draw the polygonal profile center-
snapped to the projected Center Point;

e Creating a prism with the polygonal base profile, using the Extrude tool with
a Distance that equals the height of the pyramid, and a O (degree) Taper, if
the vertex point of the pyramid is somewhere within the top surface of the
prism to be created without a Taper; or

e Creating a prism with the polygonal base profile, using the Extrude tool with
a Distance that equals the height of the prism, and a certain degree (45° for
example) Taper, if the vertex point of the pyramid is somewhere outside of
the top surface of the prism to be created without a Taper;

e Selecting the top surface of the prism to create a Sketch with the vertex point
of the pyramid, using the Project Geometry tool to project the Center Point
onto the Sketch as the vertex point; and using the Point, Hole Center tool to
create the vertex point of the oblique axis; and using the General Dimension
tool to apply linear dimensions between the vertex point and the projected
Center Point;

e Using the Work Plane tool several times to create 3-point Work Plane
features with the vertex point and two points from edges of the pyramid’s
base, the number of 3-point Work Plane features equaling the number of
edges of the base;

e Using the Split tool several times with Split Part as Method and each of the
Work Plane features as Split Tool to remove the unneeded volumes; and to
change the prism into an oblique-axis pyramid.

The basic steps in the modification of the 3D model of any regular pyramid into a
frustum of pyramid (one with the vertex removed to create a top surface parallel to the
base surface) are summarized as follow:

e Selecting the Work Plane tool and choosing the XZ Plane and the vertex
point of the pyramid as defining elements to create a Work Plane parallel to
the base of the pyramid;
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e Selecting the new Work Plane that is parallel to the base of the pyramid, to
start a new Sketch; using the Center Point Circle tool to draw a large circle
of a convenient size enclosing the visually projected area of the base;

e Using the Extrude tool with Cut as Type, Distance for Extents, the large
circle drawn in the last step as Profile, and a downward Direction, to remove
the vertex tip of the regular pyramid and to change it into a frustum of
pyramid.

The basic steps in the modification of the 3D model of any regular pyramid into a
truncated pyramid (one with the vertex removed to create a top surface at an angle
relative to the base surface) are summarized as follow:

e Selecting the XY or YZ Plane to start a new Sketch, using a variety of tools

such as Project Geometry, Line, Trim, and General Dimension to create a
closed shape with appropriate dimensions for truncating the pyramid,;

e Using the Extrude tool with Cut as Type, Distance for Extents, the closed
shape drawn in the last step as Profile, and Midplane as Direction, to remove
the vertex tip of the regular pyramid and to change it into a truncated pyramid.

For a sheet metal project with separate Face panel parts to be assembled, the
above procedures are enough for the 3D model to be used as Derived Parts for their
Work Surfaces. If the sheet metal project is to be created as a single piece with Bend
features, and if the 3D model of the pyramid is a “regular” one with the vertex tip, than
the “regular” one must be changed into a virtual “frustum” with the removal of a small
but sufficient volume of the vertex tip, using the Extrude tool with Cut as Type, a
Distance of less than one inch to one inch or above, depending on the sharpness of the
vertex tip, and a profile drawn on a Work Plane feature that is perpendicular to the axis
of the pyramid, so as to allow the Bend features associated with the Face features to be
created properly. In addition, if it is desirable, then solid metal part in the shape of the
removed vertex tip can be designed, fabricated and welded to the installed sheet metal
part.

These steps will be demonstrated in the Section 1 and Section 2 of this Module.
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Section 1:
Creating A Derived Part File For A Regular Right-Axis Pyramid
With A Triangular or Other Polygonal Base

In this part of the Module, we will create a 3D model of a triangle-based pyramid
as an example; pyramids with bases of other polygonal shapes (such as four-sided square
or rectangle, six-sided hexagon, seven-sided heptagon, and eight-sided octagon, etc.), can
be created in similar methods. The step-by-step procedures are explained below.

Step 1: Creating a triangle-based prism

Create a new Sheet Metal (in).ipt file under the English tab; click the Return
button to dismiss the default sketch and delete it from the Model panel with the Delete
key on the keyboard. Select the XZ Plane and click the Sketch button to start a new
sketch; rename the sketch as “Triangle” in the Model panel; use the Project Geometry
tool to project the Center Point onto the new sketch; use the Polygon tool with Inscribe
option and type 3 for number of sides, to draw a triangle centered at the projected Center
Point (Figure 4A-4A); click-select the Horizontal constraint tool and then the base edge
line of the triangle (shown red in Figure 4A-4B) to constrain it to a horizontal position
(Figure 4A-4C); use the General Dimension tool to apply a 48-inch dimension to the
base line (Figure 4A-4D). Click the Return button to exit the Triangle sketch.

Next, use the Extrude tool with Join as Type, 48 (inches) Distance for Extents,
and an upward Direction, create an Extrude feature of a triangular prism (Figure 4A-
4E); and rename it in the Model panel as “Triangular Prism.” Press Ctrl+s key
combination on the keyboard to save the file; in the Save As window, create a new folder
and name it as Tut-Piramid; save the file as Tut-Right Triangular-Base Pyramid.ipt in the
new folder. Also, go to the File>As A Copy As menu to save other copies as Tut-
Oblique Triangular-Base Pyramid.ipt, Tut-Oblique Triangular-Base Pyramid Vertex
Out.ipt, and Tut-Oblique Triangular-Base Pyramid Vertex In.ipt, successively, all in the
same folder, for additional Sections of this Module.
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Figure 4A-4E: Creating the triangular prism.

Step 2: Cutting a pyramidal surface with the Extrude plus Work Plane and Sketch, or
Split plus Work Plane tool combination

Next, draw the vertex point of the right regular triangle-based pyramid. Select the
top surface of the triangle-based prism; click the Sketch button for a new sketch and
rename it “Vertex;” use the Project Geometry tool to project the Center Point onto the
sketch, which serves as the vertex point of the triangle-based pyramid; click the Return
button to exit the Vertex sketch (Figure 4A-4F).

Next, create a Work Plane feature passing through 3 points (the vertex, and 2
endpoints of any edge line of the base). Click-select the Work Plane tool; move the
cursor closer to the left endpoint and then the right endpoint of the base line, click each
time when the yellow outlined circle point indicator appears; then move the cursor closer
to the vertex point, and click when the red dot point indicator appears; a new light orange
Work Plane feature with orange outline and light orange shade appears (Figure 4A-4G);
rename it as “Face Cut Plane” in the Model panel.

Figure 4A-4F‘:L‘:|J'er1e Figure 4A-4G: Creating a 3-point Work Plane for cutting

vertex point. the prism into a pyramid.
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Next, cut the prism into a pyramid. Select the Face Cut Plane Work Plane
feature and click the Sketch button for a new sketch; use the Center Point Circle tool to
draw a large circle enclosing the entire 3D model of the prism (Figure 4A-4H); rename
the new sketch “Cut” in the Model panel; click the Return button to exit the sketch
mode. Next, select the Extrude tool with Cut as Type, All as Extents and a Direction
pointing outward of the prism (Figure 4A-4H), to cut off an inclined surface out of the
prism (Figure 4A-4J); rename the new Extrude feature “Face Cut” in the Model panel.
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Figure 4A-4H: Using the Cut Sketch feature (left) and the Extrude tool to create the
pyramidal surface cut (right).

The alternative of using the Extrude tool with a profile Sketch is to use the Split
tool with a Work Plane. Select the Split tool from the Features panel; in the tool’s
dialog window, click the Split Part button in the Method section; click the Split Tool
arrow button and click-select the and click-select the Face Cut Plane Work Plane
feature on the screen or from the Model panel; click the Direction buttons in the
Remove section to make sure that the red Removal arrow is pointing outwards from the
prism; click the OK button to remove the unneeded volume from the prism (Figure 4A-
41); and rename the Split feature Face Cut Split in the Model panel. In this case, the
inclined surface split off the prism is the same as that created by the Extrude tool with a
profile Sketch; in other cases, the two approaches yield different results and offer
different advantages, as shown in Figure 4A-4J.
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I@ Split

Figure 4A-41: Using the Face Cut Plane Work Plane feature and the Split tool to
create the pyramidal surface cut (left). The resulted prism (right).

Step 3: Removing the remaining excessive volume to change the prism into a pyramid
with the Circular Pattern tool

You can repeat the same procedures to cut off the remaining two inclined surfaces
and transform the triangle-based prism into a triangle-based regular right pyramid,;
however, since this is a right pyramid, the faster way is to use the Circular Pattern tool
from the Features panel; click-select the tool, in its dialog window, click the Features
button and click-select the “Face Cut” Extrude feature (or the “Face Cut Split” feature);
next, click the Rotation Axis button and click-select the Y Axis feature from the Model
panel’s Origin folder; type 3 ul in the Count text field and 360 (degrees) in the Angle
text field; green outlined geometric indicator and blue arrowed circular rotation indicator
appear; click the OK button to remove all unneeded volumes from the prism and to
change the prism into a pyramid (Figure 4A-4K); rename the Circular Pattern feature “3
Face Cuts” in the Model window.
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Figure 4A-4J: The Extrude tool plus Sketch approach cuts off a volume of a definite
depth (under the Distance option) or indefinite depth (under the All option), which is
perpendicular to the profile (top). The Split tool plus Work Plane approach removes
the entire volume on one side of the Work Plane feature (bottom).
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Figure 4A-4K: Using the Circular Pattern tool (left) to complete the creation of the
pyramid (Right).
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Use the Rotate tool with Common View [SPACE] option to rotate the 3D model
to the top view; the vertex of the pyramid is located at the intersection of 3 edge lines
each connecting one corner of the base triangle and the vertex point of the pyramid; and
these edge lines can be extended the mid points of their opposite edges (Figure 4A-4L),
indicating that the pyramid created here is a regular right triangle-based pyramid. Now,
save the file; and also, go to the File->Save A Copy As menu to save another copy under
the name of Tut-Frustum of Right Triangular-Base Pyramid.ipt, and another copy as Tut-
Truncated Right Triangular-Base Pyramid.ipt in the same Tut-Pyramid folder, for further
learning in later Sections of this Module.
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Figure 4A-4L: The top view of the

pyramid Figure 4A-4M: Creating the Vertex Cutoff

Work Plane.

Step 4: Removing a small volume off the vertex tip to provide corner relief for a single-
piece sheet metal part with Bend features

So far, the 3D model of a regular right triangle-based pyramid has been
completed. However, if a single-piece sheet metal part enclosing such a solid is to be
created, then a technical factor called “corner relief” in sheet metal design must be taken
into consideration. Because of the way sheet metal parts are bended, there needs to be a
gap at the vertex point of the pyramid. For this objective, we will cutoff the vertex tip of
the pyramid by a depth of three times the thickness of the sheet metal material, or 0.12 in
X 3 =0.36 in (the depth depends on many factors, such as the thickness of the sheet metal
material, the dihedral angles between congruent lateral Face surfaces, the sharpness of
the vertex tip, etc.; through trial-and-errors, this is the minimum depth that works in this
case).

First, create a work plane perpendicular to the axis of the pyramid. Since this is a
right pyramid, the axis is perpendicular to the base, which is on the XZ Plane; therefore,
such Work Plane feature must be parallel to the XZ Plane as well. Select the Work
Plane tool; click-select the vertex point and then the XZ Plane on the 3D model or from
the Model panel, a new Work Plane appears (Figure 4A-4M); rename it “Vertex Cutoff
Work Plane” in the Model panel. Next, select the Vertex Cutoff Work Plane and click-
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select the Sketch tool to start a new sketch; rename the new sketch “Vertex Cut” in the
Model Panel, use the Center Point Circle tool to draw a circle of a convenient size
centered at the vertex point (Figure 4A-4N); click the Return button to exit the Vertex
Cut sketch.
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Figure 4A-4N: The Vertex Cut
sketch.
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Figure 4A-4R: The features listed in
the Model panel.

Next, use the Extrude tool with Cut as Type, the circle as Profile, 0.36 Distance
for Extents, and a downward Direction (Figure 4A-4P), cut the vertex tip off the
pyramid (Figure 4A-4Q); rename this Extrude feature “Vertex Cutoff” in the Model
panel. All features of the resulted 3D model are listed in the Model panel (Figure 4A-
4R). Save and close the file.
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Section 2:
Create a Derived Part File for a Frustum of a Pyramid
with a Triangular or Other Polygonal Base

A frustum of any pyramid is one which vertex is chop off by a plane parallel to its
base. Open the file Tut-Frustum of Right Triangular-Base Pyramid.ipt from the Tut-
Pyramid folder; click-select the Work Plane tool; move the cursor closer to the XZ-
Plane, a red outline of the XZ-Plane and an orange outline of the suggested new work
plane appear, click the mouse button once and the XZ-Plane turns blue; move the cursor
closer to the vertex point, which turns red, click the mouse button again, and a new Work
Plane parallel to one existing plane (the XZ-Plane) and passing through a point (the
vertex) is created (Figure 4A-5A). Rename it as “Top Work Plane” in the Model panel.
Next, select the “Top Work Plane” and click the Sketch button to start a new sketch;
rename it as “Frustum” in the Model panel; use the Center Point Circle tool to draw a
circle large enough to enclose the existing 3D model (Figure 4A-5B); click the Return
button to exit the Frustum sketch.

Figure 4A-5A: Creating a work plane parallel to an existing
plane and passing through a point.

M
Figure 4A-5B: The
frustum cut-off profile.

Next, use the Extrude tool with Cut as Type, 20 (inches) Distance for Extents
and a downward Direction, cut the regular triangle-based right pyramid into a frustum
(Figure 4A-5C); rename the Extrude feature as “Frustum Cut” in the Model panel. All
features of the resulted 3D model are listed in the Model panel (Figure 4A-5D). Next, use
the Rotate tool with Common View [SPACE] option to rotate the 3D model to the top
view; the shape of the top surface is an offset of the shape of the base surface, with
parallel corresponding edge lines (Figure 4A-5E), indicating that this is a frustum of a
triangle-based pyramid. Save and close the file.
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Figure 4A-5D: The features
listed in the Model panel.

Figure 4A-5E: The top view.

Section 3:
Creating A Derived Part File For A Truncated Right-Axis Pyramid
With A Triangular or Other Polygonal Base

Step 1: Creating the truncated pyramid

A truncated pyramid is one which vertex is chop off by a plane inclined to its
base. Open the file Tut-Truncated Right Triangular-Base Pyramid.ipt from the Tut-
Pyramid folder; click-select the YZ Plane in the Model panel, right-click for the shortcut
menu and turn on Visibility (Figure 4A-6A); click the Sketch button to start a new
sketch; rename the sketch “Truncation 1” in the Model panel; use the Look At tool to
switch the sketch to an orthographic view; use the Project Geometry tool to project the

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4A: 4A- 14
Creating The 3D Model of Right and Oblique Pyramids

base edge line onto the sketch (Figure 4A-6B), and use the Line tool to draw an inclined
line close to the vertex of the pyramid; draw two horizontal lines and a vertical line from
the top and bottom endpoints of the projected base edge line; use the Trim tool to trim
off the excessive segments of all lines, so that the sketch on the screen matches Figure
4A-6C; next, select the General Dimension tool, click on the projected base edge line
and the endpoint of the inclined line (Figure 4A-6C), and apply a linear dimension of 36
inches (Figure 4A-6D), and an angular dimension of 30° between the base edge line and
the inclined line; right-click for the shortcut menu and choose Done to exit the General
Dimension tool. Next, use the Trim tool again to trim off all excessive line segments and
to leave a clean profile for the truncation cut; click the Return button to exit the
Truncation 1 sketch.

_ Figure 4A-6B: Projecting  Figure 4A-6C: Picking the
Figure 4A-6A: the base edge line. projected base edge line and the
Selecting the YZ Plane. endpoint of the inclined line.

&
i

Edit Dimension : d10
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Cancel |

Figure 4A-6D: Applying linear and Figure 4A-6E: The truncation cut.

angular dimensions and trimming off
excessive line segments.

Next, use the Extrude tool with Cut as Type, All as Extents and Midplane as
Direction to apply a truncation cut to the pyramid (Figure 4A-6E and Figure 4A-6F).
Rename the Extrude feature as “Truncation Cut 1” in the Model panel. Use the Rotate
tool with the Common View [SPACE] option to rotate the 3D model to the top view;
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between the truncated top surface and the base surface, one pair of edges that are
perpendicular to the YZ Plane are parallel, but the other two pairs are not; and the shape
of the top surface is not an offset of the shape of the base surface, like the one seen in
Section 2 of this Module (Figure 4A-6G), indicating that this is a truncated triangle-based
pyramid. Save the file.
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Step 2: Exploring the effects of changes of height and angle of the truncating profile
on the truncated pyramid’s 3D model

We will now study the effects of the height and the angle of truncating plane on
the top view of the 3D model of pyramids. Switch to an isometric view. Click-select the
“Truncation 1” Extrude feature in the Model panel, right-click for the shortcut menu and
choose Show Dimensions option (Figure 4A-7A), the sketch and dimensions connected
to the Extrude feature appear on the 3D model; double-click the linear and then the
angular dimension features, type new values (20 in and 20 deg for linear and angular
dimensions respectively, as shown in Figure 4A-7B), then click the green checkmark to
apply the change; next, click the Update button in the Command Bar (Figure 4A-7C),
the 3D model updates. Next, use the Rotate tool with the Common View [SPACE]
option to rotate the 3D model to the top view; the shape of the top surface is enlarged and
appears closer to the shape of the base surface (Figure 4A-7D), indicating that a smaller
height gives a larger top truncated surface. Next, switch to isometric view again; change
the angular dimension to 5 (degrees); and use the Update tool in the Command Bar to
update the 3D model again; and rotate the 3D model back to the top view using the
Rotate tool with the Common View [SPACE] option; the shape of the truncated top
surface looks more “parallel” to the shape of the base surface; and if the angular
dimension is changed to 0°, then the truncated pyramid becomes the frustum of a pyramid
and the shapes of both top and base surfaces will be exactly offsets of each other, with
exactly parallel corresponding edge lines. Hold the Shift key on the keyboard and press
the Z key to undo the changes. Save the file.

Step 3: Learning how to use the Suppress Features and Unsuppress Features options

Next, we will apply a truncation to the pyramid from a profile drawn on the XY
Plane, which is not perpendicular to any edge of the triangular base of the pyramid. We
will first suppress the first truncating feature. Click-select the “Truncation Cut 1”
Extrude feature in the Model panel; right-click for the shortcut menu and choose the
Suppress Features option (Figure 4A-7E); the regular right triangular-based pyramid
without the truncation reappears (Figure 4A-8A). In Inventor, the Suppress Features
function temporarily removes targeted and associated features from the 3D model; and
after they are “suppressed,” the Suppress Features option is changed into Unsuppress
Features option in the same shortcut menu, and the suppressed features can be brought
back into the 3D model by the Unsuppress Features option.

Select the XY Plane and click the Sketch button to start a new sketch; rename it
“Truncation 2” in the Model panel. Switch to orthographic view with the Look At tool;
draw a similar truncation profile as shown in Figure 4A-8B; using similar methods as in
the last step; click the Return button to exit the Truncation 2 sketch; and apply a similar
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Extrude cut to truncate the pyramid (Figure 4A-8C). Name the new Extrude feature
“Truncation Cut 2” in the Model panel. Next, use the Rotate tool with the Common
View [SPACE] option to rotate the 3D model to the top view; between the shape of the
truncated top and the shape of the base surface, no pair of corresponding edges is parallel
(Figure 4A-8D).

Next, select the Truncated Cut 2 feature in the Model panel, right-click for the
shortcut menu and choose the Suppress Features option to suppress it; next, select the
Truncated Cut 1 feature in the Model panel, right-click for the shortcut menu and choose
the Unsuppress Features option and to unsuppress it. The isometric view of the model
will look like Figure 4A-8E. All features of the model are listed in the Model panel
(Figure 4A-8F). Save and close the file.

Edit Dimension : d18
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Section 5:
Creating A Derived Part File For A Square-Based
Regular Right-Axis Pyramid

Step 1: Creating a triangular-based prism

Launch Inventor, start a new Sheet Metal (in).ipt file under English tab. Turn
Visibility on for XZ and XY and YZ Planes, plus the Center Point from the Model
panel. “Sketch1” is created by default in the Model panel’s XY Plane (the one parallel to
your computer’s screen). Go to View-> Isometric for better visualization in 3D space;
and click the Look At tool button to return to orthographic view and start drawing the
cross-section of a regular right prism, which shall be cut into a pyramid in the next step.
From the Sketch panel, click-select the Project Geometry tool to project the Center
Point onto the sketch first; then select the Polygon tool with Inscribed option to draw a
triangle (Figure 4A-9A); use the Horizontal constraint tool to constraint the base line of
the triangle to horizontal position (Figure 4A-9B); use the General Dimension tool to
apply a 36-inch dimension to the base line. Click the Return button to exit the Sketch
mode. Rename the sketch “Pyramid” in the Model panel. Save the file as Tut-Right
Regular Square Pyramid.ipt, inside the Tut-Pyramid folder.

Next, use the Extrude tool with 36-inch for Distance and Midplane for
Direction, complete the 3D prism feature (Figure 4A-9C). Rename the Extrude feature
“Triangular Prism” in the Model panel.

¥ DN @ A

=4l = = D

Polygon -

Harnzantal

Figure 4A-9B: The Horizontal
constraint tool.

Figure 4A-9A: Starting the profile sketch
for a regular right prism
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Figure 4A-9C: The Extrude tool.
Step 2: Cut the triangular-based prism into a rectangular-based pyramid

Next, click-select the YZ Plane (Figure 4A-9D), the Sketch and Look At tool
buttons and start a new sketch to draw the cut-off profile transforming the triangular
prism into a square-based pyramid; click-select the Project Geometry tool and project
the Center Point and the base line of the triangular prism onto the new sketch (Figure
4A-9E); click-select the Polygon tool, choose the Circumscribe option and type 3 in the
number of sides text field for a triangle; click on the projected Center Point, move the
cursor to the mid point of the projected base line, and click when the green snap indicator
appears (Figure 4A-9F) to complete the triangle; next, click-select the Circle center
Point tool to draw a circle starting at the projected Center Point with a convenient radius
that allows the circle to enclose the entire prism (Figure 4A-9G); next, click the Return
button to exit the sketch, and rename the sketch as “Cut” in the Model panel.

Next, select the Extrude tool with Cut as Type, All as Extents and MidPlane as
Direction (Figure 4A-9H), and the space between the triangle and the circle as Profile,
cut the prism into a square-based regular right pyramid (Figure 4A-91); rename the
Extrude feature as “Pyramidal Cut” in the Model panel. Save the file. Also, go to
File=>Save A Copy As menu to save another copy of the file under the name of Tut-
Oblique Square Pyramid, and another copy as Tut-Twice Oblique Square Pyramid.ipt, in
the same folder, for further learning in later Sections of this Module. Close the file.
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Figure 4A-9D: Start a cut-off
profile sketch.

I
Figure 4A-9F: Draw the triangle.

4A- 20

Figure 4A-9E: Project the base line onto
the new sketch

Figure 4A-9G: The cut-off profile.
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@I ak. I Cancel |

Figure 4A-9H: Cut the prism into a pyramid.
Figure 4A-91: The complete
regular square-base
pyramid.

We have created a 3D model of a square-based regular right-axis pyramid with a
sharp vertex at the top. Due to the characteristics of sheet metal material and the way cut
metal sheets are bent, no sheet metal part wrapping this pyramidal space can actually
create this sharp pointed vertex; instead, a corner relief is needed (Figure 4A-9J);
therefore, the actual space the sheet metal part wraps is a frustum of a pyramid, although
in the assembly process, extra material can be welded on the vertex and sanded into a
sharp corner, but this is not our concern here. Thus, in order to allow the sheet metal part
to be created correctly and in a workable way, we will cut a tiny depth of the vertex tip in
the derived part, with a cutoff profile sketch drawn on a plane perpendicular to the right
axis of the square-based pyramid. The step-by-step procedures are explained in the next
paragraphs.

,:______________F_______,_, B ‘
th FlatPatten

| corner relief
at vertex of
pyramid

Figure 4A-9J: The sheet metal part wrapping the square-based regular right-axis
pyramidal space. The folded part (left); the entire flat pattern (middle); and the vertex
area with corner relief (right).

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4A: 4A- 22
Creating The 3D Model of Right and Oblique Pyramids

Step 3: Cut off the vertex tip of the rectangular-based pyramid

Click-select the Work Point tool; move the cursor closer to the vertex point; click
once at the appearance of the yellow outlined circular point indicator; a light yellowish
point appears on the vertex point (Figure 4A-9K), and the feature appears in the Model
panel under the name of Work Point1, with a solid blue dot as its symbol (Figure 4A-9L);
rename it Vertex Work Point. Next, select the Work Plane tool; click-select the Vertex
Work Point (Figure 4A-1M), and then the XZ Plane (Figure 4A-9M), either on the screen
or in the Model panel; the new work plane is created; it is perpendicular to the right axis
of the pyramid, which coincides with the Y Axis of the Inventor’s digital space and
passes through the vertex point (Figure 4A-9N); rename it Vertex Cutoff Work Plane in
the Model panel.

Next, select this Vertex Cutoff Work Plane and start a new sketch; draw a circle of
any convenient radius approximately centered at the vertex point (Figure 4A-9P); rename
the sketch Vertex Cut in the Model panel; click the Return button to exit the Sketch
mode.

I & Work Points I Cﬂ Work Plane

i
+[1+

x
Model ~
Y
- Tut-Right Regular Square Pyramid ipt
EHC] Origin
| YZ Plane
‘-
XV Plane
1—& XA!!&
Y s
Lﬂ Z Buis
L Center Paint
(@) Triangular Prism

Figure 4A-9K: The Work o5 Poremicl Cu

f—@- Yertex Work Paint

Point tOOI ~E3 Endof Part
Figure 4A-9L: Picking the Vertex Work Point.
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Figure 4A-9M: Picking the Figure 4A-9N: The Vertex

XZ Plane. Cutoff Work Plane. Figure 4A-9P: The Vertex

Cut sketch.

Next, use the Extrude toot, with Cut as Type, Distance typed as 0.24 (inch) for
Extents, and a downward Direction (Figure 4A-9Q), cut the vertex tip off with the
Vertex Cut sketch profile (Figure 4A-9R); rename the Extrude feature Vertex Cut in the
Model panel. The value of Distance here is double the intended thickness of the sheet
metal material (0.12 inch); this value should be adjusted if needed due to several factors
including the dihedral angles between the lateral sheet metal panels if the sheet metal part
is a whole piece. Such adjustment can be done from the inside the sheet metal file, as
shall be explained in Module 5B. If the pyramidal space is instead wrapped by four
separate triangular-shaped sheet metal parts, then corner relieves are not needed and the
sheet metal parts can extend all the way to the vertex point. If the part is of small size
with a flat pattern that can fit into a single metal sheet, then one-piece design is suitable;
if it is of large size which single-piece flat pattern cannot fit into a single metal sheet,
then multiple-piece design is a more suitable option.

Figure 4A-9R: The
vertex cutoff.

Figure 4A-9Q: The Extrude options.
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Section 6:
Creating A Derived Part File For A Regular Square-Based Pyramid With
An Axis Oblique In One Direction

In this Section 7 and 7 of the Module, we will learn how to change an existing
feature by changing its sketch profile.

Open the Tut-Oblique Square Pyramid, from the same folder. From the Model
panel, select the “Cut” sketch and right-click for the shortcut menu and choose Edit
Sketch (Figure 4A-10A); select the Wireframe Display mode from the Command Bar
(Figure 4A-10B) for better visualization. Select the two angled lines of the triangle profile
and press the Delete key on the keyboard to delete them. Select the Project Geometry
tool to project the lower-right corner point onto the new sketch for a snap point (Figure
4A-10C), then right-click for the shortcut menu and choose Done to exit the tool; select
the Line tool to draw an angled edge line connecting this projected point and the top
endpoint of the vertical base line; and draw another angled edge line starting from the
projected point and extending out of the vertical base line, at any convenient angle
(Figure 4A-10D). Use the Trim tool to trim off the segments of the lines outside of the
new triangle and use the General Dimension tool to apply a 24-inch dimension to the
vertical base line (Figure 4A-10E); right-click for the shortcut menu and choose Done to
exit the tool (Figure 4A-10F); click the Return or the Update button to exit the sketch
mode and update the 3D model. The 3d model of the original right-axis square-based
pyramid is changed into a square-based triangular pyramid with an axis oblique in one
direction. Go to View->Isometric menu to view the new model (Figure 4A-10G). In the
Model panel, rename the “Pyramidal Cut” as “Oblique Cut” (Figure 4A-10H). Save and
close the file.

— C|[T0F# |0
7 _|@ ] teszage m

E-f Tut-Right Regular Square Pyramid.ipt @

=Hafl Triangular Prism @
L@g Pyramid ||

Lk Cut ['wireframe Dizplay|

¥ End of Part
Figure 4A-10B: Wireframe  Figure 4A-10C:
Figure 4A-10A: The Display mode. Delete the angled
Model panel. edge lines and

project the lower-
right corner point.
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Figure 4A-10G: The
square-based triangular Figure 4A-10H: The Model panel.
pyramid with an axis

obligue in one direction.

Section 7:
Creating A Derived Part File For A Rectangle-Based Pyramid With An
Axis Oblique In Two Directions

Open the Tut-Twice Oblique Square Pyramid.ipt file. In the Model panel, rename
the “Triangular Prism” Extrude feature as “Oblique Triangle Prism,” and the “Pyramid”
Sketch feature as “Oblique Triangle;” rename the “Pyramid Cut” Extrude feature as
“Twice Oblique Cut” and its dependent “Cut” Sketch as “Twice Oblique” (Figure 4A-
11A) In the Model panel, select the “Oblique Triangle,” right-click for the shortcut menu
and select Edit Sketch option (Figure 4A-11B). The screen switches to sketch mode;
click-select the Line tool; from the top vertex of the triangle, draw a horizontal
construction line to restraint the height; next, click-select the horizontal construction line
as well as the two inclined edge lines of the original equilateral triangle, and go to the
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Command Bar to change the Style of these lines to Construction (in Inventor,
Construction lines in the Sketch features do not participate in the creation of 3D solid
features; these three construction lines can be deleted with the Delete key on the
keyboard before the completion of Edit Sketch operation is desired); next, use the Line
tool to draw an inclined line from the right endpoint of the base line extending beyond the
top horizontal construction line; apply an angular dimension of 115° to the angle between
this inclined line and the horizontal base line (Figure 4A-11C); click-select the Trim tool
and trim off the portion of this inclined line against the top horizontal construction line;
next, use the Line tool to draw another inclined line connecting the top endpoint of the
first inclined line and the left endpoint of the horizontal base line, using green snap
indicators for accuracy while drawing lines. The profile of an oblique triangle with the
same height as the original equilateral triangle is completed. Click the Return or the
Update button in the Command Bar. The 3D model of a prism with an oblique
triangular base appears (Figure 4A-11D). Save the file.
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Figure 4A-11A: The new Model panel Share Sketch
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Figure 4A-11B: Edit Sketch.
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horizontal construction line

Edit Dimension : d12

S~ Figure 4A-11D: The oblique
inclined edge lines of triangular prism.
the original equilateral triangle

Figure 4A-11C: The new “Oblique
Triangle” sketch.

inclined
edge lines

Figure 4A-11F: The twice oblique
square-based pyramid.

lower-right
corner point

Figure 4A-11E: The oblique triangle.

The next step is to cut the oblique triangular prism into an oblique square-based
pyramid. Select the “Twice Oblique” Sketch feature from the Model panel; right-click for
the shortcut menu and select the Edit Sketch option; the screen switches to the Sketch
mode; go to the Command Bar to change the Display mode to Wireframe Display for
better viewing of the 3D model’s geometry; click-select the Look At tool button from the
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Command Bar and then the “Twice Oblique” Sketch feature from the Model panel to
switch to the normal view of the sketch; delete both inclined side edge lines of the
triangle in the original sketch; next, use the Project Geometry tool to project the lower-
right corner point of the prism onto the sketch for a snap point; and from this point, use
the Line tool to draw two inclined lines to the top endpoint and midpoint of the vertical
edge line of the original equilateral triangle profile; an oblique triangle is formed; next,
use the trim tool to trim off the lower segment of the vertical edge line that is beyond the
oblique triangle (Figure 4A-11E). Click the Return button. The oblique prism is
transformed into a square-based pyramid with an axis twice oblique in two directions
(Figure 4A-11F).

To see that this square-based pyramid has an axis that is oblique in two directions,
click-select the Rotate tool, right-click for the shortcut menu and choose the Common
View [SPACE] option (Figure 4A-11G); the Common View cubic symbol appears; click
the green arrow along any edge, the arrow turns red (Figure 4A-11H) and the common
orthographic view replaces the isometric view (Figure 4A-31); continue clicking the
green arrow on the edges until the top view is seen (Figure 4A-111), this top view shows
that the vertex of the pyramid is located off the center of the square base, in two
directions, indicating that the axis of the pyramid is oblique in two directions, or away
from the Y-Axis along both X-Axis and Z-Axis. To exit the Rotate tool, right-click and
choose Done in the shortcut menu (Figure 4A-11J). Save the file.

If desired, you may open the Tut-Oblique Square Pyramid, and Tut-Right Regular
Square Pyramid.ipt files inside the same Tut-Pyramid folder, and perform similar step to
make a comparison. In the case of the right square-based pyramid, in the Tut-Right
Regular Square Pyramid.ipt file, the vertex of the pyramid is right at the center of the
square base, indicating that the axis of the pyramid is straight right up (Figure 4A-1K). In
the case of the square-based pyramid with an axis oblique in one direction, in the Tut-
Oblique Square Pyramid file (Figure 4A-11L), the vertex of the pyramid is located off
the center of the square base, in one direction, indicating that the axis of the pyramid is
oblique in one direction, or away from the Y-Axis along the Z-Axis.

P
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Figure 4A-111: The top view of the
square-based pyramid with an axis
oblique in two directions.

Figure 4A-11H: Switch to
orthographic view.

Eedefine [sametnc
[ PanView +F2

A ZoomWiew +F3

Frevious View  +Fh

Isomelrc View Figure 4A-11K: Right square-based
How To... pyramid.

Figure 4A-11J: Exit the Rotate tool.

Figure 4A-11L: The top view of the
square-based pyramid with an axis
oblique in one direction.
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Next, we will cut off the vertex tip of the oblique pyramid with a depth along the
oblique axis of the pyramid, so as to provide a “corner relief” for the single-piece sheet-
metal part, as explained in the previous Section 5 of this Module. In the case of a pyramid
with an axis oblique in two directions, the axis is neither coincident nor parallel with any
of the X, Y, and Z Axis of the Inventor’s digital space; and the plane used to draw the
cutoff profile sketch for the vertex tip is not perpendicular to any of the existing YZ, XZ,
and XY Planes; therefore, hold the Shift key and click-select the YZ, XZ, and XY
Planes in the Model panel, and then right-click for the shortcut menu and uncheck
Visibility (Figure 4A-11M), so as to avoid visual confusion by features that are not
essential to the task. In order to create the work plane for the cutoff profile sketch, the
oblique axis must be first established. The oblique axis passes through the vertex and the
center point of the base. Therefore, we need to establish these two points first. The
procedures to complete this task are explained as follows. Select the base surface of the
oblique pyramid and click-select the Sketch button from the Command Bar to start a
new Sketch; use the Project Geometry tool to project the four edge lines and use the
Line tool to draw two diagonal construction lines; then use the Point, Hole Center tool
to draw a point at the intersection of the two diagonal construction lines (which appears
as a cross, as shown in Figure 4A-11P), all with the help of green snap indicators (Figure
4A-11N); rename the sketch Base Center Point Construction in the Model panel; click
the Return button to exit the Sketch mode. Next, create two work points; select the
Work Point tool; move the cursor closer to the vertex point and at the appearance of the
yellow snap indicator, click once to create a work point and rename it Vertex Work Point
in the Model panel (Figure 4A-11Q); then move the cursor closer to the point drawn at
the intersection of the two diagonal lines on the base, click once to create a work point
when the “cross” point symbol turns red, and rename it Base Center Work Point in the
Model panel (Figure 4A-11R). Use the Rotate tool to access the vertex point of the
pyramid if necessary.

1
Model » 2]
Y
._?p-—gji Tut-Twice Oblique Square Pyramid.ipt
!_--—I_] Ongm
o o

Z F In:m D

‘ Copy Ctrl+C A"f#’ 2 /

'—E Create Note % > 3igUI’e 4A-11M:
[|— Wisibility . & 4 Urning V|S|b|||ty off
% e or all three Planes.
L E  HowTo.

T+

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4A: 4A- 31
Creating The 3D Model of Right and Oblique Pyramids

Figure 4A-11N: Selecting the base surface (left); projecting the edge lines and drawing
diagonal construction lines.

| -#- Work Points

<> Point, Hole Center

Figure 4A-11P: picking the point of
intersection (left) and creating the Base

Center Work Point (right). Figure 4A-11Q: Creating the Vertex
Work Point.

Next, create the work axis passing through the two work points just created.
Select the Work Axis tool; click-select the Vertex Work Point and the Base Center Work
Point features in the Model panel or on the screen; the orange work axis appears on the
screen; rename the new Work Axisl feature Oblique Work Axis in the Model panel
(Figure 4A-11S). Next, create a new work plane that contains both the Oblique Work Axis
and the Y Axis, on which a centerline oblique axis can be drawn. Select the Work Plane
tool and click on the Y-Axis and Oblique Work Axis features in the Model pane. A new
work plane appears (Figure 4A-11T); rename the new work plane Oblique Axis Work
Plane in the Model panel.
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Figure 4A-11R: The Base Center
Work Point (red cross).
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Figure 4A-11S: The Oblique Work Axis through the Vertex Work Point

and the Base Center Work Point.

Next, select the Oblique Axis Work Plane and click the Sketch button to start a
new sketch; since the oblique axis will be hidden inside the 3D pyramid, go to the
Command Bar to the display mode to Wireframe Display for better visibility; use the
Line tool to draw a line snapping to the Vertex Work Point and the Base Center Work
Point; and go to the Command Bar to change the Style of this line to Centerline for
better visualization (Figure 4A-11U); rename the new sketch Oblique Axis Centerline in

the Model panel.
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Next, create a work plane perpendicular to the Oblique Axis Centerline. Select the
Work Plane tool again; move the cursor closer to the Vertex Work Point and click once;
then move the cursor closer to the centerline oblique axis just drawn and click once when
it turns red (Figure 4A-11V); the new work plane appears on the screen; rename the new
work plane feature Perpendicular to Oblique Axis Work Plane in the Model panel.
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Figure 4A-11U: The Oblique Axis Centerline sketch drawn on the
Oblique Axis Work Plane.

- [ work Plane

Figure 4A-11V: Creating the Perpendicular to Oblique Axis Work Plane.
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Next, use the Rotate tool to rotate the 3D model and view the perpendicular
relationship between the Perpendicular to Oblique Axis Work Plane and the Oblique
Work Axis; they appear to be perpendicular. Next, click-select the Perpendicular to
Oblique Axis Work Plane, and then click the Look At tool button; the orthographic view
appears on which centerline oblique axis “disappears” (it turns into a point, or PV, which
stands for “point view” in descriptive geometry terminology); this proves that both
features are perpendicular to each other (Figure 4A-11W). Next, select the Perpendicular
to Oblique Axis Work Plane, and click the Sketch button to start a new sketch; use the
Circle Center Point tool to draw a circle with any convenient size and centered at the
vertex (Figure 4A-11X); rename the sketch Vertex Cut in the Model panel.

Figure 4A-11W: Investigating the perpendicular
relationship between the centerline oblique axis and Figure 4A-11X: The Vertex
the Perpendicular to Oblique Axis Work Plane, with Cut sketch.

the Rotate (left) and Look At (right) tools.

Next, use the Extrude tool with Cut as Type; type 0.875 (inch) as Distance for
Extents, and a downward Direction to cut off the vertex top of the pyramid; and rename
the new Extrude feature Vertex Cutoff in the Model panel (Figure 4A-11Y). The sheet
metal part latter designed wrapping this oblique pyramidal space is shown on Figure 4A-
117 and.
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Figure 4A-11Y: The
Extrude tool settings
(left); the cutoff
vertex (right); and
the features listed in
the Model panel
(bottom right).
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=] Vertex Cutoff
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End of Part

Figure 4A-11Z: The sheet metal part. 3D
Folded model (top); 2D flat pattern (bottom).
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Section 8:

Creating A Derived Part File For An Oblique Pyramid With A Triangular
or Other Polygonal Base Other Than A Square or A Rectangle, With A
Vertex At One Corner of The Top Surface

Open the Tut-Oblique Triangular-Base Pyramid.ipt file from the same Tut-
Piramid folder. Click-select the Work Plane tool; move the cursor closer to the left and
right endpoints of the frontal base edge line, and the rear corner of the top surface, and
click once at each point when the outline yellow circle snap indicator appear; a new work
plane appears (Figure 4A-12A); rename it in the Model panel “Cutoff Surface Work
Plane.” Next, select this plane and click the Sketch button to start a new sketch; use the
Circle Center Point tool to draw a circle large enough to enclose the whole prism
(Figure 4A-12B); click the Return button to exit the sketch mode and rename the new
sketch “Cutoff” in the Model panel. Next, use the Extrude tool with Cut as Type, All as
Extents and outwards from the prism as Direction, and the circle as Profile (Figure 4A-
12C), cut the prism into an oblique triangle-based pyramid (Figure 4A-12D); rename the
Extrude feature “Surface Cutoff” in the Model panel (Figure 4A-12F).

//

Figure 4A-12A: Creating the _ w .
«Cutoff Surface Work Plane. Figure 4A-12B: The “Cutoff” sketch.
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Figure 4A-12C: The Extrude tool.

Since the vertex is a corner point of the top surface and the base is triangular, no
further cuts are needed. To view the geometric relationships of edge lines, surfaces and
points in the 3D model, use the Rotate tool with Common View [SPACE] option to
rotate the 3D model to the top view; it is obvious that the two angled edges of the top
surface overlap their corresponding edges on the base surface; and that the vertical edge
is shared by both top and base surfaces (Figure 4A-12E). The features of the 3D model
are listed in the Model pane (Figure 4A-12F). Save the file.

4

Fiqure 4A-12D- Figure 4A-12E: Rotating the 3D model to the top view. On
Thge complete ' the top view, two edges of the top surface overlap their
pyrami dp corresponding edges of the base surface.
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Browszer Bar
Model ~ 7]
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Cutoff Surface Work, Plane
EH&] Surface Cutoff

L« Cutaff
@ Endof Far Figure 4A-12F:
Al |_21| The resulting Model panel.
Section 9:

Creating A Derived Part File For An Oblique Pyramid With A Triangular
or Other Polygonal Base Except A Square Or A Rectangle, With A Vertex
Is Outside of The Top Surface

To create an oblique pyramid with a polygonal base other than a square or a
rectangle, with a vertex that is outside the top surface of the first extruded prism feature,
the first feature of triangular-based prism must be created in such a way that the top
surface is larger than the base surface, so that the vertex point can still be located within
the 3D body (in other words, the first feature of triangular-based prism); this can be
accomplished by creating the first feature of triangular-based prism Extrude feature as a
tapered one, not as a regular “straight up” one.

Open the Tut-Oblique Triangular-Base Pyramid Vertex Out.ipt file from the same
Tut-Piramid folder. Click-select the Triangular Prism feature from the Model panel;
right-click for the shortcut menu and choose Edit Features option; in the Extrude tool
dialog window that opens, type 45 (degrees) in the Taper text field (the taper angle
needed is proportional to the distance between the vertex points of the oblique pyramid
and the projected center point of the base on the plane that contains the vertex point and
is parallel to the polygonal base of the pyramid; and trial-and-errors might be needed for
determining the angle); a gray taper indicator appears, with an arrow pointing outward of
the light green base surface profile, indicating that the top surface will be larger; click the
OK button; the regular prism changed to a tapered prism with a much larger top surface
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(Figure 4A-13A). Use the Rotate tool with Free Rotate option to rotate the model to a
convenient position where both top and base edges can be seen (Figure 4A-13B).

Extrude : Triangular Prism [X] |

~Shape — Extents

| Distance _'J
|48 in |

A
‘Iw\mlmﬁ
5

@I 0K Cancel

Figure 4A-13A: Change the regular prism into a tapered prism with a
larger top surface.

Figure 4A-13B: Rotating the 3D model to
a convenient position.

Next, click-select the top surface of the tapered prism, click-select the Sketch tool
to start a new sketch for the vertex point; rename the sketch “Vertex” in the Model panel;
click the Look At button and then the “Vertex” Sketch feature in the Model panel to
switch to the orthographic normal view; switch from Shaded Display to Wireframe
Display from the Command Bar, so that the outlines of both the top and base surfaces
can be seen; use the Project Geometry tool to project the Center Point onto the sketch;
next, click-select the Point, Hole Center tool from the Sketch panel; click once inside
the space between the edge lines of the larger top surface and of the smaller base surface
(Figure 4A-13C); the vertex point appears as a cross; next, use the General Dimension
tool to apply a 20 in (inches) horizontal linear dimension and a 30 in (inches) vertical
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linear dimension between the projected Center Point and the vertex point drawn with the
Point, Hole Center tool; next, click the Return button to exit the Sketch mode.

| ¢ Point, Hole Center

Figure 4A-13C: The Point, Hole
Center tool and the Vertex sketch.

Figure 4A-13E: The *“Cutoff 1~
profile sketch.

Figure 4A-13F: Cutting off one surface of
the pyramid.
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Figure 4A-13G: The completed oblique pyramid.

Next, click-select the Work Plane tool; move the cursor closer to the left and
right endpoints of the frontal base edge line, click once at each of the two points when the
outline yellow circle snap indicator appear; a new work plane appears; then move the
cursor closer to the vertex point on the Vertex Sketch, and click once when the vertex
point turns red (Figure 4A-13D); a new work plane is created; rename it in the Model
panel “Cutoff Work Plane 1.” Select this plane and click the Sketch button to start a new
sketch; use the Circle Center Point tool to draw a circle large enough to enclose the
whole prism (Figure 4A-13E); click the Return button to exit the sketch mode and
rename the new sketch “Cutoff 1” in the Model panel. Next, use the Extrude tool with
Cut as Type, All as Extents, outwards from the prism as Direction, and the circle as
Profile, cut one surface of the pyramid out of the 3D body of the prism (Figure 4A-13F);
rename the Extrude feature “Surface Cutoff 1” in the Model panel. Repeat the same
procedures to cut off the remaining two surfaces and complete the oblique pyramid
(Figure 4A-13G). Rename each Work Plane, Sketch and Extrude features as shown in
Figure 4A-131. Save the file.
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Figure 4A-131: The Model
panel features.

Next, analyze the spatial relationships of surfaces, edges and points by using the
Rotate tool with Common View [SPACE] option to rotate the 3D model to the top and
bottom views; the top view shows two foreshortened inclined lateral surfaces; and the
bottom view shows one foreshortened inclined lateral surface and one true-shape base
surface (Figure 4A-10H). Save and close the file.

Section 10:

Creating A Derived Part File For An Oblique Pyramid With A Triangular
or Other Polygonal Base Other Than A Square or A Rectangle, With A
Vertex Inside of The Top Surface

To create an oblique pyramid with a polygonal base other than a square or a
rectangle, with a vertex that is inside the top surface of the first extruded prism feature,
the vertex point should be created first on the top surface. Once this step is completed, a
combination of Work plane, Sketch and Extrude (with Cut option) can be used to
change the prism into an oblique pyramid, as explained in the previous Section 9 of this
Module. An alternative method is to use the Work Plane and Split tools, as explained in
Section 1 of this Module (page 4A-6).

© Edward Locke 2007 (edwardnlocke@yahoo.com)
FOR EDUCATIONAL USE ONLY. ALL RIGHTS RESERVED.



Inventor (5) Module 4A: 4A- 44
Creating The 3D Model of Right and Oblique Pyramids

Open the Tut-Oblique Triangular-Base Pyramid Vertex In.ipt file from the same
Tut-Piramid folder. Click-select the top surface of the triangular prism (Figure 4A-14A);
click the Sketch button to start a new sketch; rename it “vertex” in the Model panel; click
the Look At button to switch the sketch to an orthographic (normal) view; use the
Project Geometry tool to project the Center Point onto the Vertex sketch; use the Point,
Hole Center tool to draw the vertex point above and to the right of the projected Center
Point; use the General Dimensions tool to apply a 8-inch horizontal linear dimension
and a 6-inch vertical dimension between the vertex point and the projected Center Point
(Figure 4A-14B); click the Return button to exit the sketch mode.

Figure 4A-14B: Drawing a
vertex point and apply linear

Figure 4A-14A: dimensions between the vertex
Selecting the top and the Center Point. Figure 4A-14C: Creating
surface for a new the first 3-point cutoff
sketch. work plane.

Next, click-select the Work Plane tool; move the cursor closer to the left and
right endpoints of the frontal base edge line, click once at each of these two points when
the outline yellow circle snap indicator appear; then move the cursor closer to the vertex
point on the Vertex sketch, and click once when the vertex point turns red (Figure 4A-
14C); a new Work Plane feature is created; rename it in the Model panel “Cutoff Work
Plane 1.” Select this plane and click the Sketch button to start a new sketch; use the
Circle Center Point tool to draw a circle large enough to enclose the whole prism
(Figure 4A-14D); click the Return button to exit the sketch mode and rename the new
Sketch feature “Cutoff 1” in the Model panel. Next, use the Extrude tool with Cut as
Type, All as Extents, outwards from the prism as Direction, and the circle as Profile,
cut one surface of the pyramid out of the 3D body of the prism; rename the Extrude
feature “Surface Cutoff 1” in the Model panel (Figure 4A-14E). Use the Work Plane,
Sketch, and Extrude tools, repeat the same procedures to cut off the remaining two
surfaces and complete the oblique pyramid (Figure 4A-11F).
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Next, to see how the oblique axis’ vertex affects the top view of the model, select
the Look At button and click-select the Vertex Sketch feature in the Model panel (Figure
4A-14G); from the top view, it is obvious that the vertex pulls all edges of the pyramid
with it. Rename all remaining Work Plane, Sketch and Extrude features as shown in the
Model panel (Figure 4A-14H). Save and close the file.

Extrude : Surface Cutaff 1

Estents

[T
BsI
[ ok | cance |

Figure 4A-14E: Using the Extrude tool.

/
/

Figure 4A-14D: The cutoff
sketch for an extrude cut.
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Figure 4A-14H: The Model
panel features.
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Congratulations! In this somehow lengthy Module with 10 Sections, you have
learned the basic methods of creating the 3D models of most, if not all types of right and
oblique pyramids, and observed the 3D spatial relationships of surfaces, edge lines and
corner points of 3D models in Inventor’ s 3D digital space.
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